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Stellar Phoenix Linux Data Recovery 3.0, an advanced easy-to-use software recovers and restores 
Linux files from damaged or corrupt Linux EXT2, EXT3 partitions. The software runs on Windows 
platform and extracts your precious files from the inaccessible Linux hard drive. Powerful algorithms 
used in the software will scan the whole drive thoroughly to locate all the lost partition and deleted 
files/folders. These files finally restore to a safe location. This user guide will walk you through the 
entire software and make you familiar to the software. 
  
Stellar Phoenix Linux Data Recovery 3.0 is the updated version of Stellar Phoenix Linux 2.5, ensures 
the recovery of Linux files after a hardware crash, virus attach, software malfunctioning or formatted 
Linux hard drive 
 
 
Key features of Stellar Phoenix Linux Data Recovery : 
 

· Recovers lost, deleted and formatted partitions 
· Restore lost / missing / deleted files and folders 
· Raw data recovery from inaccessible drives 
· File filter – to recover specific file type 
· Image files accelerate the recovery process 
· Facility to preview graphic files, MS Office files, Web documents etc. 
· Well-designed and interactive user interface 
· Provide live update 
· Multi disk support – recover data from IDE, SATA and SCSI drives 
· Compatible with windows 2000, XP, 2003 and Vista 

  
 



 ��������	� �
 

3 

 

�
����	� ��	����	�	����

  
 
 

  
  

Minimum System Requirements 
 

 
Processor :  Pentium class 

 Operating System :  Windows 2000 / XP / 2003 / Vista 

 
Memory :  128 MB or more of Random Access Memory (RAM) 

 
Hard Disk: 35 MB of free space 
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To install the software successfully go through the following steps. 

  
Step 1: 

Insert the Stellar Phoenix v3.0 CD into CD-ROM drive and wait for a while to start the setup 
automatically or open the drive and double click the Setup icon. 
   
Step 2: 

The welcome page of the setup wizard will appear. Click Next  to continue. 
   
Step 3: 

The next screen shows the license agreement, Please review it carefully. 
If you agree with the terms, select I accept the agreement  option and click Next . 
   
Step 4: 

In this step you can specify the folder where the software is to be installed. Click Next  to continue. 
The default location is C:\ Program Files \ Stellar Phoenix Linux Data Reco very 
  

Note : 
To install software to a new location, click on  Browse  and select the folder. 
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Step 5: 

The Start Menu Folder  window will appear. Here, you can specify the folder to place the Program 

shortcut in Start -> Programs menu. Click Next  to continue. 
  

·  By default, Setup creates a new folder named Stellar Phoenix Linux Data Recovery  
and place the shortcut there. 

·  To select different folder, click on Browse  and select the folder. 
 
  
Step 6: 

You get Select Additional Tasks  window. Here, you can create desktop and quick launch icons. 
Check the required options and click Next  to continue. 
  
  
Step 7: 

Next Ready to Install window will appear. You can view the summary of the Installation settings. 
Click Install  to begin installation. 
  
  
Step 8: 

Now Setup will copy the required files to the hard disk. The progress bar will show the status of the 
installation process. 
   
  
Step 9: 

Installation is now complete. Click Finish  to exit Setup. 
  

To run the software immediately after exiting the Setup program, leave the check 
mark in the check box next to Launch Stellar Phoenix Linux Data Recovery , 
else clear the check box. 

  
   

  
Note: 

Do not install Stellar Phoenix to the partition from which you are trying to recover data. 
This may result in overwriting of your lost data and cause permanent damage. 

  
 
 
 
 
 
 
 
 
 
 
 



 ��������	� �
 

5 

 
 

Order and Activate 
 
 

Order Stellar Phoenix Linux Data Recovery: 
 
You can purchase the software online. For price details and to place the order, please visit 
http://www.stellarinfo.com//disk-recovery-prices-linux.htm 
  
Once your order is confirmed, a pre-paid serial # will be sent to you through e-mail, which 
would be required to activate the software. 

   
  
Activate Stellar Phoenix Linux Data Recovery: 
  
 

  
Note: 

·  If the software is downloaded from http://www.stellarinfo.com//disk-recovery-
prices-linux.htm (i.e., ESD version), for the full functionality, the product must be 
activated using Serial Key  (received through email after purchasing the product). 

 
·  If the software is installed using the product installation CD (i.e., BOX version), 

hardware lock  is mandatory for the functioning of the software which is available 
with the software kit. 
  

  
 
Stellar Phoenix Instant Activation over Internet 
  
Once you purchase and receive the serial key (pre-paid key received through email after purchasing 
the product), activate the product instantly over Internet. 
  
To activate the software, 
  

·  Click Activation -> Activate Online in the menu bar, the following window appear. 
  

 
  
  

·  Click Yes, the software checks for the Internet connection. Once it is connected, software 
registration wizard will appear. 
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·  Click Next , to continue further with the registration process.  
 
·  In the window that appears, type the Serial number (received through email after purchasing 

the product) in the textbox.  
 

·  Click Next  to continue. The software would automatically communicate with registration server 
and would activate the software, as shown below. 

    
  

 
  
  
Stellar Phoenix Activation using Email 
  
While activating the product over Internet, if the software could not communicate with the server, an 
error message shown below will popup. Click OK, for registering through email. 
  

 

  

·  The registration wizard for sending the authorization request will appear(shown below), as soon as 
you click OK. 
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·  Leave the option unchecked and click Next  to continue. 
 
·  Following window appear, you have to type your email address in the text box to which the 

unlocking code is to be send. Once you have entered the email address, click Next . 
  

 
  

  
·  The email address verification window will appear. Click Yes, if email address is 

correct. 
   

The software automatically launches the default email client, and sends an email containing 
your unique site code with registration request to the registration server. 
   
If the registration wizard could not launch the default email client, following messages will 
appear.  
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·  Click OK, to continue the process manually.  
·  The window shown below appears. 
 

  

 
 
 

·  Open your email client (like Outlook Express, MS outlook, Eudora etc) and create a new 
message.  

 
·  Place the cursor in the box labeled TO and press CTRL+V to paste address. If it does not 

work, right click on the TO box and select paste from the popup menu. The TO box will 
contain the address as shown below. 

 
·  Click Next , following window will appear. 

 
·  Now place the cursor in the box labeled Subject in the same message window and paste 

(method same as above) the text. The Subject box will contain the text as shown below.  
 

·  Click Next , do the same process mentioned to paste the encrypted text content in the body 
of the message.  

 
·  Click Next  to finish the procedure and send the email. 

    
    

 

Make sure the content of the email sent for automat ic authorization have 
the details as mentioned above. If they are incorre ct, the server will reject 
your mail registration request. 

 
·  If the process is successful, following window will appear. 

  
After processing your email, registration server would send you an email containing unlocking 
code/site-key. 
    

  
Note: 

In case wizard is not able to launch the default email client, it automatically 
shifts to the manual process for sending the activation authorization request. 
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Activation without Internet 
  

·  If you try to activate the product, without Internet connection following window pops up. You have 
to enter the Serial Number (received through email) and click Next . 

  

 
  

·  You get the following window, click Finish . 
  

 
  

Manual registration is complete, software would create a PHX_REG.txt file on your desktop and you 
just need to email this file to register@stellarinfo.com. 

After verifying your details, we would send the unlocking code/site key to you through email. 

  

To activate the product manually (after receiving the site-key): 

·  Click Activation -> Manual Registration in the menu bar.  

·  You get the following window, enter the Site Key and click Validate, to activate the 
software.   

 

   
  

Note: 
All manual registration process will take maximum of one business day for completion. 
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1. Insert the hardware lock  (  - available with the software kit) into any USB port on the computer. It is 
mandatory to attach the hardware lock for the functioning of the software.  

 
If hardware lock is not attached or unplugged while operating the 
software, an error message will appear and the software will not run. 

 
2. After the system successfully detects the lock, run the software.  
 
3. To start the application, do one of the following: 

      
· Click Start  => Programs = > Stellar Phoenix Linux Data Recovery  =>Stellar Phoenix Linux 

Data Recovery  
 
· Double click the shortcut icon on the desktop . 
 
· Click quick launch icon on the taskbar . 

   
  

  
Note: 

·  If the software is downloaded from http://www.stellarinfo.com//disk-recovery-
prices-linux.htm (i.e., ESD version), for the full functionality, the product must 
be activated using Serial Key  (received through email after purchasing the 
product).  

·  If the software is installed using the product installation CD (i.e., BOX 
version), hardware lock  is mandatory for the functioning of the software 
which is available with the software kit.  

·  The desktop and quick launch icons are optional. 
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After Stellar Phoenix completes its installation procedure, the main user interface will appear. The 
user interface contains all you need to perform a complete data recovery. 
   
Main User Interface 

The initial screen, which appears after starting the software, is shown below. 
 

  
 
 
Note: 

At every startup, Tip of the Day  window appears. It displays important information related to the 
software. To view more tips, click Next Tip and to exit, click Close . To disable the window at 
startup, uncheck the option Show Tips on Startup  at the bottom of the window. 
 
To enable Help -> Show Tip of the Day  in the menu bar. 
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Drives Menu 
  

Show Drive List : To create drive tree using existing drive list. 

Refresh Drive List : To create and show drive list again. 

Open Drive Using Scan Information : To open the scan information saved before. 

Open Image File : To open the image file created by the software. 

Exit : To close the application. 

  

File Menu 
  

Recover All : To recover all lost files from the scan result. 

Recover Selected : To recover the selected files from the scan result. 

Add File Filter : To include or exclude files based on given criteria. 

Remove File Filter : To remove the filter. 

  

Tools Menu 
  

Stop Current Process : To halt the current process. 

Save Scan Information : 
To save the scan result.  (ie, the directory tree structure generated 

after disk/drive scan) 

Advance Settings : To set the advanced features. 

Find : To search files of a specific type from the scan result. 

Find Next (F3) : To select the next file of the type specified in the Find command. 

File Mask : To view/recover specific file types based on used-defined criteria. 

Show Original List : 
To generate the complete list of lost/deleted files in the tree 

structure. 

Select All : To check all the files in the tree structure. 

Unselect All : To clear all the check boxes. 

Save Log : To save log information. 

Clear Log : To clear log information. 

Append Header File : 
To add / edit / delete header files. (Company header cannot be 

deleted). 

File Preview : To view the complete details of the selected drive. 
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View Menu 
  

Toolbar : Show / Hide toolbar. 

Status bar : Show / Hide Status bar. 

Message Log : Show / Hide log window. 

Go Up : To go one level up to the parent directory of the selected folder. 

Large Icon / Small Icon / List / 

Details 
: To change the preview of the files in the right panel. 

Arrange : To arrange the files in the right panel by Name, Type, Size, 

Modified date, Created Date, Last accessed date and File ID. 

  
Language Menu 
  

English : Software Interface available in English. 
Français : Software Interface available in French. 
Deutsch : Software Interface available in German. 
Español : Software Interface available in Spanish. 
Italiano : Software Interface available in Italian. 

  

Activation Menu 
  

Activate Online : To activate the software which has been purchased. 

Manual Registration : To register the software manually. 

  
  

Help Menu 
  

Help Topic : To open user guide. 

Order Stellar Phoenix…. : Purchase details of the product. 

Update Stellar Phoenix…. : Opens the update wizard, to check for the latest version. 

Email Stellar Support : Opens the outlook express, to send the email. 

View Support Section : Opens Stellar support section webpage. 

View Knowledge base articles : Opens knowledge base article webpage. 

Generate a Ticket : Opens the login page, to submit ticket. 

Show Tip of the day : To view tip of the day. 

About Stellar Phoenix…. : To view the general information regarding the software. 
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Disk / Drive context menu 
  

Disk / Drive Preview : Shows Disk Size, Disk No., Serial No. etc 

Properties : Shows the property sheet of the selected disk / drive.  

  
  

Folder / File context menu 
  

Preview : Shows Disk Size, Disk No., Serial No. etc and also 
preview the graphic files (gif, bmp,png, tiff), MS Office files 
(doc, xls, ppt) etc. 

Select/Unselect : To check & uncheck the files and folders. 

Recover : To recover the selected file/folder. 

Rename : To change the name of file/folder. 

Show Properties : Shows the property sheet of the file/folder.  

  �

&


#���
  
 
 

   
Show Drive List : Create drive tree using existing drive list. 

Refresh Drive List : Create and show drive list again. 

Add File Filter : Used for selective recovery. 

Recover All : Used to recover all files. 

Recover Selected : Used to recover selected files 

File Mask : Show selective items. 

File Preview : Show the contents of the drive / files. 

Find & Find Next : Used to search file(s). 

Go Up : To go one level up to the parent directory of the selected folder. 

Stop Current Process : Used to stop the currently running process. 

Online Update : Update the product with the latest version available. 

Purchase Stellar Phoenix..  : Used to order the product. 

Help Topic : Used to open user guide. 
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Log window will display useful information about the ongoing activity. In Stellar Phoenix Linux Data 
Recovery, the log window displays the history of the software activities. The window shows - Activity, 
Description and Status of the software. 

 
To save the log information you can use Save Log  in the Tool  menu. When you click Save Log  
option, Save Log to File  window will pop up. You can specify the location to save the file and click 
Save. The file will be saved as a text file (.txt) in the specified location. 
 
File already exist window pops up, if you try to save log report in the file name that already exist. The 
window consists of: 
 

Filename that already exist text box : The path and filename of the existing log report appear in 
this text box.. 

New Name text box : The path and new filename of the log report appear in this 
text box. 

 
: This will change the filename of the existing file to new 

filename(given in the New Name text box) or you can give 
any filename. 

 
: This will overwrite the existing file. 
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Stellar Phoenix Linux Data Recovery software is capable of recovering lost data from any drive 
(physical disk or logical drives) in the hard disk or any removable media. Once you have installed the 
software, start the application.  
 
The initial screen, which appears after launching the software, is shown below. 
  

 

  
The screen consists of menu bar, toolbar, tree structure (left pane), main area (right pane) and log 
window. 
  
The tree structure in the left pane shows the drive structure of the system - ie, the physical disk, the 
logical drives (partitions in the physical disk represented as C:, D:) and the CD/DVD drive. 
  
CD/DVD drive will be visible in the tree view if it contains CD/DVD. 
  
You can search the lost logical drives from the physical disk and recover the data from it. Similarly, 
lost files/folders from the existing logical drives and CD/DVD drive can be scanned and recovered. 
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The physical disk in the system consists of two or more drives (logical drives, which are represented 
as C:, D:). The logical drives in the physical disk may be lost due to various reasons such as a 
simple voltage fluctuation or a virus attack. Stellar Phoenix Linux Data Recovery will search for 
these lost drives and recovers the data from it. 

   
 

To recover lost data from physical disk: 
  

·  Double click on Physical disk in the left pane. 
·  You get a Select Appropriate Action window as shown below. 
·  You can select the required action mentioned in the 

window: 
     

Search Logical Drive  - This option will search 
for all the lost logical drives in the physical disk. 
Standard and Advanced search are available. 
Standard search will be sufficient to explore the 
lost drive. However, if unable to find the lost 
drive, then go for advanced search. While 
searching is going on, each lost drive discovered 
will be added to the tree structure. Finally, all the 
discovered logical drives will appear on the tree 
structure.  
  
Raw Data Recovery  - This option will recover raw data from badly corrupted drive. At 
times, search options will be unable to discover lost data from badly damaged disk. In 
that situation, raw data recovery option will help you to extract all the data from the 
severely damaged hard disk and displays the result in the tree according to the file 
types. You can recover either all or selected file(s) from the scan result. In this method, 
you can search drives for known file types or search from a selected region. 
  
Create Image File  - This option will generate an image of the physical drive. First, the 
file is saved with the file extension .img  in the specified location and then the software 
creates the image of the drive reading sector by sector. A key feature of Stellar Phoenix 
Linux Data Recovery is that an image of the whole drive can be created or user can 
specify a region of the drive. The image file created can be further scanned and data 
can be recovered from it. 
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To recover lost data from logical drives: 
  

·  Double click on logical drive (drive from which data 
is to be recovered) in the left pane. 

·  You get a Select Appropriate Action window as 
shown below.  

·  You can select the required action mentioned in the 
window: 

   
Scan Logical Volume  - This will provide three 
types of scanning – Standard Scan, Advanced 
Scan and Deleted File Recovery. Standard and 
advanced scan will examine the entire logical 
volume and display all the files and folders, 
except the deleted ones. On the other hand, 
Deleted File Recovery will display only the 
deleted files. 
 
Raw Data Recovery  - This option will recover raw data from badly corrupted 
volume/drive. It extracts all data from severely damaged disk and display the result in 
the tree view according to the file types. You can recover all or selected file(s) from the 
scan result. In addition, specific file type can be recovered from a selected region. Every 
sector of volume will be searched for specified signature. 
  
Create Image File  - This option will generate an image of the logical volume/drive. First, 
the file is saved with the file extension .img  in the specified location and then the 
software creates the image of the drive reading sector by sector. A key feature of Stellar 
Phoenix Linux Data Recovery is that an image of the whole drive or an image of 
specified region of the drive can be created. The image file created can be further 
scanned and data can be recovered from it. 
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To recover lost data from CD/DVD drives: 
 

·  Double click on CD/DVD drive in the left 
pane. 

 
·  You get a Select Appropriate Action 

window as shown below.   
 
·  You can select the required action 

mentioned in the window: 
  

Raw Data Recovery  - This option will 
recover raw data from badly corrupted 
CD/DVD. At times, search options will be unable to discover lost data from badly 
damaged disk. In that situation, raw data recovery option will help you to extract all the 
data from the severely damaged disk and displays the result in the tree according to the 
file types. You can recover either all or selected file(s) from the scan result. In addition, 
you can search CD/DVD for known file type. Every sector of CD/DVD will be searched 
for specified signature. 
  
Create Image File  - This option will generate an image of the drive. First, the file is 
saved with the file extension .img  in the specified location and then the software creates 
the image of the drive reading sector by sector. The image file created can be further 
used to recover data. 
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To recover lost data from image file of the physica l disk: 
  

·  Double click on image file of the physical 
disk in the left pane.  

·  You get a Select Appropriate Action window 
as shown below.  

·  You can select the required action 
mentioned in the window: 

  
Search Logical Drive  - This option  will 
search for all the lost logical drives in 
the physical disk. Standard and 
Advance search are available. Standard 
search will be sufficient to explore the lost drive. However, if you are unable to find the 
lost drive, then go for advance search. While searching is going on, each lost drive 
discovered will be added to the tree structure. Finally, all the discovered logical drives 
will appear on the tree structure.  

  
 

Raw Data Recovery  - This option will recover raw data from badly corrupted drive. At 
times, search options will be unable to discover lost data from badly damaged disk. In 
that situation, raw data recovery option will help you to extract all the data from the 
severely damaged hard disk and displays the result in the tree according to the file 
types. You can recover either all or selected file(s) from the scan result. In this method, 
you can search drives for known file types or search from a selected region. 
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To recover lost data from image file of the logical  drive: 
  

·  Double click on image file of the logical drive in the left pane.  
·  You get a Select Appropriate Action window as shown below.  
·  You can select the required action mentioned in the window: 

   
  

Scan Logical Volume  - This will provide three 
types of scanning – Standard Scan, Advanced 
Scan and Deleted File Recovery. Standard 
and advanced scan will examine the entire 
logical volume and display all the files and 
folders, except the deleted ones. On the other 
hand, Deleted File Recovery will display only 
the deleted files. 
  
Raw Data Recovery  - This option will recover 
raw data from badly corrupted volume/drive. It extracts all data from severely damaged disk 
and display the result in the tree view according to the file types. You can recover all or 
selected file(s) from the scan result. In addition, specific file type can be recovered from a 
selected region. Every sector of volume will be searched for specified signature. 
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To recover lost data from image file of CD/DVD driv e: 
 

·  Double click on image file of the 
CD/DVD drive in the left pane.  

·  You get a Select Appropriate Action 
window as shown below.  

·  Click on Raw Data Recovery , to 
extract raw data from the image file. 

  
  

Raw Data Recovery  - This option will recover raw data from badly corrupted CD/DVD. 
At times, search options will be unable to discover lost data from badly damaged disk. In 
that situation, raw data recovery option will help you to extract all the data from the 
severely damaged disk and displays the result in the tree according to the file types. 
You can recover either all or selected file(s) from the scan result. In addition, you can 
search CD/DVD for known file type. Every sector of CD/DVD will be searched for 
specified signature. 
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In this chapter, you will learn more about Stellar Phoenix Linux Data Recovery v3.0. Each module of 
the software is explained in detail. In addition to the basic process, advance options like Add File 
Filter, Advance Settings, File Mask, File Preview etc are included. A brief summary of the basic 
modules is given below. 
  
 

 

Search Logical Drives:  

All the lost drives from the physical disk or removable media will be discovered. 

Standard search finds the drives quickly, if unable to discover lost drive go for 

advanced search. 

 

Raw Data Recovery:  

In this section, corrupted media is searched to find the lost logical drives. It is 

possible to search known file types and selected region. 

 

Create Image File:  

An image of the drive is created. This file can be used for recovering data. Image will 

be created sector by sector and you can also specify the region for creating the 

image. 

 

Scan Lost Data:  

This section explains about the scanning process. Standard and Advance scanning 

options are available. The scan result is displayed in the left panel in tree form. 

 

Recover Lost Data:  

The final and the most important stage, recovery of lost/deleted files. You can 

recover either all or selected files. 

   
  
NOTE:   

If you hear any strange noises (grinding or clicking) coming from your hard drive this might be 
an indication of a hardware/physical problem. Continuing to operate your system may damage 
your hard drive beyond repair and/or cause irretrievable data loss. If you suspect hardware 
problems visit :www.stellarinfo.com/data-recovery-services 
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The search option will examine the entire drive for the lost volumes and simultaneously it adds each 
discovered volume to the tree view. At the end of the process, the search result will contain all the lost 
logical volumes from which you can recover the lost / deleted data. 
 
To start the process: 
  

·  Double click the physical disk in the left panel.  
·  Click Search Logical Drive , which will open the window shown below. 

   

 
  

·  You can select the search option according to the requirement. Usually standard search will serve 
your purpose, if not go for the advanced search.  

 
·  The searching of the drives proceeds and all the lost logical drives are discovered. You can view all 

the discovered drives on the tree structure as shown below.  
 

·  Next, you have to scan the logical drive from which data is to be recovered, for that double click the 
discovered logical drive. After scanning, scan result will be added to the tree structure. Now, you 
can recover either all or select the file from the scan result. In addition, you can also create an 
image of the logical drive. 

 
  
  

  
Note: 

Standard Search:  This will search the physical disk to find all the lost logical 
drives. In most cases, standard search will be sufficient. It will quickly and efficiently 
scans the entire drive to discover lost drives. 
 
Advance Search:  Advance Search will locate the lost drives in a physical disk, 
when the drives are not identified using Standard Search. When there is a serious 
damage to critical data structure attributes then you should use advance search to 
locate lost/missing partitions.  
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This module will explain how to recover data from a badly corrupted media. At times, search options 
will be unable to discover lost data from badly damaged disk. In that situation, raw data recovery 
option will help you to extract all the data from the severely damaged hard disk and displays the 
result in the tree according to the file types. In addition, you can search drives for known file types 
and search from a selected region. 
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To extract raw data from physical disk / image file  : 
  

·  Double click on the physical disk.  
·  Click Raw Data Recovery , it start searching the physical disk for known file type. 

 
 In addition, you can search disk for known file types and search from a selected region 
of the disk. 

 
·  After the process, all the raw data found will add to the tree structure in the left pane. 
·  When the process is complete, you can recover all the files or selected file(s) from the tree 

structure. 
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To extract raw data from logical drive: 
  

·  Double click the logical drive in the left pane.  
 
·  Click Raw Data Recovery , searching will start 

In addition, you can search disk for known file types and search from a 
selected region of the disk. 

 
·  After the process, all the raw data found will add to the tree structure in the left pane. 
 
·  When the process is complete, you can recover all the files or selected file(s) from the tree 

structure. 
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To extract raw data from CD/DVD drive: 
  

·  Double click on the CD/DVD Drive.  
 
·  Click Raw Data Recovery , the software will search the CD/DVD drive. 

  
In addition, you can search CD/DVD for known file types. 

  
·  After the process, all the raw data found will add to the tree structure in the left pane.  
 
·  When the process is complete, you can recover all the files or selected file(s) from the tree 

structure. 
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This module will generate an image of the drive, which can be further scanned and recovered. 
  
First, the file is saved with the file extension .img  in the specified location and then the software 
creates the image of the drive reading sector by sector. A key feature of Stellar Phoenix Linux Data 
Recovery is that an image of the whole drive can be created or user can specify a region of the 
drive. The image file created can be further scanned and data can be recovered from it. 
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To create image file of physical disk: 

  
·  Double click the physical disk.  
 
·  When you click Create Image File , Save As  dialog box will pop up, give the filename or use the 

default one and specify the location.  
 
·  As soon as you click the save button, the software begins to create the image of the drive and the 

same will be added to the tree structure in the left panel. 
  

In addition, the software can create an image of the specified region of the drive. 
  

·  You can search for logical drives or raw data from the image file of the physical disk. After 
extracting logical drives from the image file, scan and recover data from it. 
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To create image file of existing logical drives: 
  

·  Double click on the logical drive.  
 
·  Click Create Image File , Save As  dialog box will pop up, give the filename or use the default one 

and specify the location.  
 

·  As soon as you click the save button, the software begins to create the image of the drive and the 
same will be added to the tree structure in the left panel. 

    
In addition, the software can create an image of the specified region of the drive. 

 
·  The image created can be used for recovering data. If you want to recover data from an image file 

created by the software, first scan the image file and recover the file(s). 
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To create image file of CD/DVD drive: 
  

·  Double click on the CD/DVD drive.  
 
·  Click on Create Image File  , Save As  dialog box will pop up, give the filename or use the default 

one and specify the location.  
 

·  As soon as you click the save button, the software begins to create the image of the drive and the 
same will be added to the tree structure in the left panel.  

 
·  After image file creation, you can extract the raw data from the image file and result will be added to 

the tree structure. Now, you can recover either all or selected file(s) from the result. 
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To begin the scanning process, you have to select the drive or the image file from which data is to be 
recovered. Then the software scans entire drive or the image file and add the file(s) to the tree 
structure. 
  
If you are satisfied with the standard scan result, start the recovery process. Otherwise, use the 
Advanced scan to get all the lost file(s). 
  
Standard Scan  - Scan performed in most cases, which quickly and efficiently scan the selected media 
for lost files. 
  
Advanced Scan  - This method takes more time to scan but has greater chance to discover lost data. It 
scans each cluster of the logical drive.  
 
Deleted File Recovery  -  This option will scan only for the deleted files and it takes more time since 
the software analyze each sector of the logical volumes for deleted files. The scan result will contain 
only the deleted files and folders.  

  ���
�
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Standard Scan is performed in most cases since it retrieves the 
lost data quickly and efficiently by scanning the entire disk. If 
you are not satisfied with the standard scan result, then go for 
advanced scan, which takes more time but has greater chance 
to discover lost data. It scans each sector of the disk for known 
file type and gives you the best result.  
 
 
To start the scanning process: 
  

· Click on the Standard Scan or Advance Scan icon. 
· The software will scan and display all the recoverable 

files in the tree view. 
· Now you can recover the folders/files from the scan 

result. (See section Recover Lost Data) 
 

�
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Deleted File Recovery option will search only for the deleted files and it takes more time since the 
software analyze each sector of the logical volumes for deleted files. The scan result will contain only 
the deleted files and folders.  
 
 
To search for deleted files: 
  

· Click on the Deleted File Recovery icon. 
· The software will scan the drive for known file types and display all the deleted folders/files in the 

tree view. 
· Now you can recover these folders/files from the scan result. 
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After scanning or raw data recovery of the drive or the image file, lost file(s) can be recovered. There 
are two recovery options: 
 
  
To Recover All Lost Files 
  

·  Click Recover All  icon on the Toolbar  or Files -> 
Recover All, following window popup.  

 
·  Here, you have to specify - destination, file creation 

and recovery options and click OK. 
 
   
To Recover Selected File(s) 
  

·  Select the file(s) by clicking the checkbox next to 
them.  

 
·  Click Recover Selected  icon on the Toolbar  or Files 

-> Recover Selected, following window popup. 
 

You can also enable Recover Selected option by 
right clicking the file or folder. 
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·  Here, you have to specify recovery destination option and file creation option.  
 
·  After choosing the options, click OK. 

   
The recovered file(s) will be saved in the specified folder. 
  
 
 
Recovery window at a glance 

  
Recovery Destination Option 

Stellar phoenix allows you to recover the files to three destinations - Local drive, FTP server and 
CD/DVD drive. You can choose any option to recover the files. 

  
Recover to local drive  - Browse and specify the destination location. 
Recover to FTP server  - Specify the server name / IP address, username and 
password. 
Recover to CD/DVD drive  - Files will be recovered to CD/DVD drive. 

  
  
File Creation Option 

To create recovered files in zip (compressed) format, check Create zip file . 
Two options available: 
 

·  Zip each file individually  - If you select this option, each file recovered will be  
compressed separately.  

·  Zip to a single file  - If you select this option, all the files recovered will be compressed 
to a single zip file. 

 
   

Recovery Option (only available for Recover All option) 

Three recovery options are available. Choose the appropriate option: 
 

·  All file(s) and folder(s) [ Exclude deleted file(s)  & folder(s)] - This option will 
recover all the file(s) and folder(s). However, recovery of the deleted file(s) and 
folder(s) will not take place.  

·  All file(s) and folder(s) [ Include deleted file(s)  & folder(s)]  - This option will recover 
all the file(s) and folder(s), including the deleted file & folder.  

·  Only deleted file(s) & folder(s) - This option will recover only the deleted file(s) and 
folder(s). 

 
  

  
  
Note: 

Never save the data to the partition or drive from where you are recovering data, as it 
may result in overwriting of data, and would result in permanent data loss!!! 
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This section guides you through the advanced features of the software. The additional 
features/controls explained in this module really makes the software exceptional. 
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File Filter 
File filter is an advanced feature that accepts or rejects files based on the given criteria. 
  

  
  
In Stellar Phoenix Linux Data Recovery software, recovery of files can be done by including or 
excluding files based on certain criteria using Add File Filter feature.  
 
For example, if you want to recover only the graphic files (*.jpeg,*.bmp,*.tiff etc), select the graphic 
file option from the drop down menu and add these file types to the list and click Include . After 
recovery, only graphic files will be transferred or recovered. 
  
Similarly, if you want to exclude any file type, select the file type and click Exclude . (Recovery of all 
file types takes place, except the excluded ones) 
  
  
To Add File Filter:  
 
 

·  Click Add File Filter  icon on the toolbar or Files  -> Add File 
Filter on the menu bar.  

 
·  Select the file type from the drop down menu or include any 

other file type and click Add . The file type will be listed as 
shown below. 

   
In addition to the file types in the list, you can add in other file types also. You have to type 
in the file type and click Add , the file type will add to the list box.  

 

·  You can include or exclude the file type, by clicking Include  or 
Exclude  buttons. 

  
 Either you can include or exclude a file type in one go. 

  
To remove File Filter, click Remove File Filter  option in the Files  
menu. 
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Advance settings consist of five options.  This option can be accessed from the Tools menu (Tools -
> Advance Settings). In the window that pops up, click on the checkbox next to each category to 
select the settings options. 
  

·  Check the first option, to automatically search for the updates at startup.  
 
·  While exiting from the application, to get an alert for saving the log report, check the third 

option. Click Browse  and select the folder, to set the path for saving the log report.  
 

·  Number of Read Attempts  option will allow you to specify the number of times the sectors 
are to be read by the software. By default, software reads the sector three times. While 
scanning a disk with bad sectors, you can speed up the scan process by setting the Number of 
Read Attempts option to one.  

 
·  Date format can be selected from the Change Date Format  option. 
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Header File 
Information that is needed by several different files or functions is collected into a header 
file. A header file contains C-language definitions and structures. The information in a 
header file facilitates the creation and update of programs. 

  
  
  

Stellar Phoenix Linux Data Recovery displays all the supported 
header files in the Add New Header  window. You can add, edit 
and delete the header files. In case of company header, removal of 
header is not possible, you can only edit the file size. 

  
  

To Add User-defined Header 
  

·  Click Add  button in the Add New Header , following window 
pops up.  

 
·  You have to specify the name of the software, group to 

which it belongs (like application, database etc), file 
extension, maximum file size and header info. 

   
·  Click OK. The user-defined header file will be added to the 

existing header files. 



 ��������	� �
 

32 

  
  
To Edit Header File 
  
 

·  Select the header file that is to be edited.(eg., to edit 
Microsoft Access file, select the header file)  

 
·  Click Edit  button, following window popup. 

 
·  Make the required changes ( in case of company header, 

only the file size can be edited) and click OK. 
  

For removing the header file, select the header and click Remove button. 
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File Mask 
File Mask is used to view /recover specific file types based on user-defined criteria. 

  
  
  

After a disk/drive has been scanned, the software displays a directory tree listing all lost/deleted files. 
File Mask is used to display only specific file types and not the entire list of deleted/lost files. The 
original directory tree can always be regenerated by clicking Tools ->Show Original List. 
 

·  Click either the File Mask  button on the toolbar  or Tools->File Mask on the menu bar will 
display the File Mask window: 

   

The File Mask window has fields, using which specific file types 
may be identified: 

File of Type  - Use this field to generate a tree containing 
files with specific names and/or extensions (wildcards may 
also be used). Multiple entries, separated by semi-colons, 
can also be specified. 

This function can also be configured to: 
Look for the exact file name/type, that is, make the search 
case sensitive (Match Case) 
Look only in the list of Deleted Files 
Look only in the list of Existing Files 

Size From [ KB ]  - Use this function to generate a tree 
containing files of a particular size range (in KB). 

Date - Use this function to generate a tree containing files which were Created, or 
Accessed, or Modified within a user-specified time range. This time range can be in months 
(between 1 and 999), or days (between 1 and 999), or between two user-specified dates. 

The field labeled Files of Type  is mandatory, while the rest are optional. 
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This feature of Stellar phoenix allows the user to view the complete details of the selected drive like 
size, total clusters, offset and sector. You can also preview the graphic files (gif, bmp, png, tiff), MS 
Office files (doc, xls, ppt) etc. Other drives/file types can be previewed in hex viewer.  
 
   
Disk/Drive Preview 
 

·  Select the disk/drive which you want to preview. 
·  Click File Preview  icon on the toolbar  or Tools ->File Preview on the menu bar . You can also 

enable File Preview  option by right clicking on the drive.  
    

  
File/Folder Preview 
 

·  Select the file/folder which you want to preview. 
·  Click File Preview  icon on the toolbar  or Tools ->File Preview on the menubar . You can also 

enable File Preview  option by right clicking on the drive.  
 

�� Hex viewer will show the preview of drive(s) / folder(s). 
�� Image viewer will show the preview of graphic file(s). 
�� Zip viewer will show the preview of zip file(s). 
�� File viewer will show the preview of MS Office file(s). 
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Find is used to search files of a specific type from the scan result. 

After a disk/drive has been scanned, the software displays a directory tree, listing all recoverable 
files. Find can be used to highlight files of a specific type, in the displayed directory tree. Once the 
first file is highlighted, to get the next file use Find Next . 

   
To Find a File 
 

·  Click Find  icon on the toolbar  or Tools  -> Find  on the 
menubar, following window popup. 

·  Type the file name or the file type and click Search Now . 
·  The specified file will be highlighted. If you click on Find 

Next , then the next file with the specification will be 
highlighted. 
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Find window options at a glance 
 

Find  - Used to specify the file name and/or extensions. Multiple entries must be separate by semi colons. 
This field is mandatory. 
 
Match Case    - To look for exact filename/type, ie, make the search case sensitive. 
Deleted Files   - To look for the file in deleted list. 
Existing Files   - To look for the file in the currently existing list. 
 
Advance Options: 
 
Size - To look for files which are either at least or at most a particular size. File size can be also specified 
in KB. 

Date - Use this function to generate a tree containing files which were Created, or Accessed, or Modified 
within a user-specified time range. This time range can be in months (between 1 and 999), or days 
(between 1 and 999), or between two user-specified dates. 
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Save Scan is used to save the directory tree structure generated after a disk/drive scan.  
 
To save the scan result, Tools -> Save Scan Information in the menu bar. When you click Save Scan 
Information  option, Save As window pops up. You can specify the location to save the file and click 
Save. The file will be saved as data file with .DAT extension in the specified location.  
 
To regenerate the scan result, Drives -> Open Drive Using Scan Information in the menu bar. 
 
File already exist window pops up, if you try to save log report in the file name that already 
exist. The window consists of: 
 

 

Filename that already exist text box : The path and filename of the existing file appear in this 
text box.. 

New Name text box : The path and new filename of the file appear in this text 
box. 

 
: This will change the filename of the existing file to new 

filename (given in the New Name text box) or you can give 
any filename. 

 
: This will overwrite the existing file. 
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Known file type option will help to extract and recover selected file 
types from severely damaged drive i.e. it help in selective 
recovery.  
 
For example, if you want to search mpeg files, just check the 
MPEG header and unselect all other headers. After searching, all 
the mpeg files will be added to the tree structure. 
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While creating image or recovering raw data, you can specify the region of the drive. That is, you can 
mark the sectors in the disk from where raw data is to be recovered. Similarly, for creating the image 
of a selected region, you can specify the starting and the ending sectors of the drive space. This 
feature will help to speedup the recovery process in case of drives having bad sectors. 
 
 
To specify region: 
 

·  Click selected region or specified region 
option.  

·  The image selection window shown below will 
popup.  

·  To specify the region, move the arrow placed 
on the top right and left corners of the blue 
portion. Bring the mouse pointer on to the 
arrow, click and drag till the required sector. 
You can also view and edit the starting and 
the ending sector in the boxes given. Click OK 
to continue. 

 
·  Now, the image of the specified region will be 

created and added to the tree structure in left 
pane. 
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Stellar Phoenix Linux Data Recovery v 3.0 can be removed, either by using Uninstall Stellar 
Phoenix Linux Data Recovery  program in the software or from Add/Remove Programs  in the 
Control Panel. 
  

1. Click Start  => Programs = > Stellar Phoenix Linux Data Recovery  => Uninstall Stellar 
Phoenix Linux Data Recovery  or go to Add/Remove Programs  in the Control Panel, 
select Stellar Phoenix Linux Data Recovery v 3.0 and then click Change/Remove .  

 
2. Now confirmation  window will appear. Click Yes to continue.  

 
3. Stellar Phoenix Linux Data Recovery v 3.0 will then be removed from your system. When 

the process is complete you get a message confirming removal of the software, click on 
OK. 

    

If you get a message saying 'Some elements could not be removed. These can be removed 
manually.', go to C:\Program Files and manually delete the Stellar Phoenix Linux Data Recovery 
folder (this step is optional and is not necessary for the removal of the software). 
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Stellar Phoenix Linux Data Recovery software, accompanied user manual and documentation are 
copyright of Stellar Information Systems Ltd, with all rights reserved. Under the copyright laws, this 
user manual cannot be reproduced in any form without the prior written permission of Stellar 
Information Systems Ltd. No Patent Liability is assumed, however, with respect to the use of the 
information contained herein. 

  
© 1995 - 2007 Stellar Information Systems Ltd. All rights reserved. 
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The information contained in this manual, including but not limited to any product specifications, is 
subject to change without notice. 
  
STELLAR INFORMATION SYSTEMS LTD PROVIDES NO WARRANT Y WITH REGARD TO THIS MANUAL 
OR ANY OTHER INFORMATION CONTAINED HEREIN AND HEREB Y EXPRESSLY DISCLAIMS ANY 
IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS FO R ANY PARTICULAR PURPOSE WITH 
REGARD TO ANY OF THE FOREGOING STELLAR INFORMATION SYSTEMS LTD ASSUMES NO 
LIABILITY FOR ANY DAMAGES INCURRED DIRECTLY OR INDI RECTLY FROM ANY TECHNICAL OR 
TYPOGRAPHICAL ERRORS OR OMISSIONS CONTAINED HEREIN OR FOR DISCREPANCIES BETWEEN 
THE PRODUCT AND THE MANUAL. IN NO EVENT SHALL STELL AR INFORMATION SYSTEMS LTD, BE 
LIABLE FOR ANY INCIDENTAL, CONSEQUENTIAL SPECIAL, O R EXEMPLARY DAMAGES, WHETHER 
BASED ON TORT, CONTRACT OR OTHERWISE, ARISING OUT O F OR IN CONNECTION WITH THIS 
MANUAL OR ANY OTHER INFORMATION CONTAINED HEREIN OR  THE USE THEREOF. 
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Stellar Phoenix Linux Data Recovery® is a registered trademark of Stellar Information Systems Ltd. 
  
Windows 2000®, Windows XP®, Windows 2003® and Windows Vista® are registered trademarks 
of Microsoft Corporation. 
  
All other brand and product names are trademarks or registered trademarks of their respective 
companies. 
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Stellar Phoenix Linux Data Recovery Copyright © 1995-2007 by Stellar Information Systems Ltd. 

All rights reserved. 

This license applies to the standard-licensed version of Stellar Phoenix Linux Data Recovery. 

Stellar Phoenix Linux Data Recovery License. 

Stellar Information Systems Ltd. 
  
 
Your Agreement to this License 
  
You should carefully read the following terms and conditions before using, installing or distributing 
this software, unless you have a different license agreement signed by Stellar Information Systems 
Ltd. 
  
If you do not agree to all of the terms and conditions of this License, then do not copy, install, 
distribute or use any copy of Stellar Phoenix Linux Data Recovery with which this License is 
included, you may return the complete package unused without requesting an activation key, within 
30 days after purchase, for a full refund of your payment. 
  
The terms and conditions of this License describe the permitted use and users of each Licensed 
Copy of Stellar Phoenix Linux Data Recovery. For purposes of this License, if you have a valid 
single-copy license, you have the right to use a single Licensed Copy of Stellar Phoenix Linux Data 
Recovery; if you or your organization has a valid multi-user license, then you or your organization 
have - has the right to use up to a number of Licensed Copies of Stellar Phoenix Linux Data 
Recovery equal to the number of copies indicated in the documents issued by Stellar when granting 
the license. 
  
 
Scope of License 
  
Each Licensed Copy of Stellar Phoenix Linux Data Recovery may either be used by a single person 
or used non-simultaneously by multiple people who use the software personally installed on a single 
workstation. This is not a concurrent use license. 
  
All rights of any kind in Stellar Phoenix Linux Data Recovery, which are not expressly granted in this 
License, are entirely and exclusively reserved to and by Stellar Information Systems Ltd. You may 
not rent, lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative 
works based on, Stellar Phoenix Linux Data Recovery, nor permit anyone else to do so. You may 
not make access to Stellar Phoenix Linux Data Recovery available to others in connection with a 
service bureau, application service provider, or similar business, nor permit anyone else to do so. 
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Warranty Disclaimers and Liability Limitations. 
  
Stellar Phoenix Linux Data Recovery, and any and all accompanying software, files, data and 
materials, are distributed and provided AS IS and with no warranties of any kind, whether expressed 
or implied. In particular, there is no warranty for the quality of data recovered. You acknowledge that 
good data processing procedure dictates that any program, including Stellar Phoenix Linux Data 
Recovery, must be thoroughly tested with non-critical data before there is any reliance on it, and you 
hereby assume the entire risk of all use of the copies of Stellar Phoenix Linux Data Recovery 
covered by this License. This disclaimer of warranty constitutes an essential part of this License. 
  
In addition, in no event does Stellar authorize you or anyone else to use Stellar Phoenix Linux Data 
Recovery in applications or systems where Stellar Phoenix Linux Data Recovery's failure to perform 
can reasonably be expected to result in a significant physical injury, or in loss of life. Any such use is 
entirely at your own risk, and you agree to hold Stellar harmless from any and all claims or losses 
relating to such unauthorized use. 
  
 
General 
  
This License is the complete statement of the agreement between the parties on the subject matter, 
and merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive 
jurisdiction and venue for all matters relating to this License shall be in courts and fora located in the 
State of Delhi, INDIA and you consent to such jurisdiction and venue. There are no third party 
beneficiaries of any promises, obligations or representations made by Stellar herein. Any waiver by 
Stellar of any violation of this License by you shall not constitute, nor contribute to, a waiver by 
Stellar of any other or future violation of the same provision, or any other provision, of this License. 
  

  
Copyright © 1995-2007 by Stellar Information System s Ltd. All rights reserved. 
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Our Technical Support professionals will give solutions for all your queries related to Stellar Products. 
You can either Call Us  or Go Online  to our support section (www.stellarinfo.com/support). 

  
 

 ��..
���/	
.
��	 �

24 Hrs. a day  Monday – Friday 
 

USA (Toll free) - 1-866-554-2512 

USA  - 1-315-220-6245 

UK (Europe) - +44-207-993-2293 

Germany - +49-180-110-105-0051 

India (helpline) - +91-921-395-5509 

 

Skype Id - stellarsupport 
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Chat Live with an Online technician 

Search in our extensive Knowledge Base 

  

Submit Ticket (If our Knowledge Base does not answer your question) 

  Login and view Ticket Status (If you already have a valid Ticket with you) 

  Download Documents on Product Usage (For Registered members only, i.e., user with 

login ID.  If you are an unregistered user, please visit www.stellarinfo.com/esupport/users/login) 
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Stellar Information Systems Ltd . is a trusted name in the field of Data Recovery and Data 
Protection Software for more than a decade. 
  
We provide the widest range of Data Recovery Products. Our range includes Data Recovery 
Software for almost all Operating Systems and File Systems. 
  
  
Product line: 
  
Data Recovery  : A widest range of data recovery software that helps you recover your 
valued data lost after accidental format, virus problems, software malfunction, file/directory 
deletion, or even sabotage!. More Info >> 
  
File Recovery : The most comprehensive range of file undelete and unerase software for 
Windows and MS office repair tools. More Info >> 
  
Email Recovery : A wide range of mail recovery, mail repair and mail conversion 
applications for MS Outlook, MS Outlook Express and MS Exchange useful in instances of 
data loss due to damages and corruption of Email. More Info >> 
  
Data Protection : A wide range of Prevent Data Loss, Data backup and Hard Drive 
Monitoring Applications to ensure complete data protection against hard drive crash. More 
Info >> 
  
Data Sanitization : Data cleanup and file eraser utility can delete selected folders, groups of 
files, entire logical drives, System Traces & Internet traces. Once the data have been 
removed using Stellar Wipe - Data File eraser utility, it is beyond recovery limits of any Data 
Recovery Software or utility. More Info >> 

  
  

For more information about us, please visit www.stellarinfo.com 
  
 

 


